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顧客サポート

ユーザーズガイド
序章

この章では、本マニュアル内で述べられている製品のサポート
を受けるための詳細について説明します。

ハイライト

本ガイド内でカバーするトピックス

• Microchip ウエブサイト

• 顧客への変更通知サービス

• 連絡先情報

 MICROCHIP ウエブサイト

Microchip ウエブサイト : http://www.microchip.com でオンライ
ンサポートが受けられます

ウエブサイトはファイルや情報が容易に顧客に提供されるよう
に作られています。本サイトにアクセスするには、インター
ネットアクセス環境と、Netscape® Navigator 又は Microsoft® 
Explorer® 等のウエブブラウザが必要です。ファイルは FTP サイ
トから FTP ダウンロードも可能です。

ファイル転送サイトは、ftp://ftp.microchip.com に接続された
FTP プログラム /クライアントが使用可能です。

ユーザは最新版の開発ツール、データシート、アプリケーショ
ンノート、ユーザーズガイド、記事、サンプルプログラムの
ファイルをダウンロード可能です。Microchip 社のセールスオ
フィス、販売店のリストも掲載されています。
 2004 Microchip Technology Inc. DS51331A_JP-page  1
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技術サポート

• よくある質問 (FAQ)
• オンラインディスカッショングループ - 製品、開発システム、
技術情報他多くの情報の相談ができます。

• Microchip コンサルタントプログラムメンバーのリストがあ
ります。

• Microchip 製品に関連した他のウエブサイトへのリンク

開発者用ツールボックス

• 設計の秘訣情報

• デバイスの正誤情報

その他追加情報

• 最新の Microchip 社の新聞発表ニュース

• セミナーや行事表

• 採用情報

顧客への変更通知サービス

顧客への通知サービスを利用すると、Microchip 製品に関して最
新の情報を入手可能です。購読手続きを行うと、個別製品ファ
ミリーもしくは開発ツールに関連した変更、アップデート、改
定もしくは正誤表が発行される毎に e- メールで通知されます。
登録するには、Microchip ウエブサイト (www.microchip.com)
にアクセスし、"Customer Change Notification", をクリックし、
指示に従って登録ください。

開発システム製品は下記の通り分類されます。

コンパイラ ----Microchip C コンパイラとその他の言語ツールに
関する情報で、以下を含みます。MPLAB® C17, MPLAB C18, 
MPLAB C30 C コンパイラ ; MPASM, MPLAB ASM30 アセンブ
ラ ; MPLINK™, MPLAB LINK30 リンカ ; MPLIB™, MPLAB 
LIB30 ライブラリアン。

エミュレータ ----Microchip インサーキイトエミュレータに関す
る情報で、MPLAB ICE 2000 と MPLAB ICE 4000 を含みます。 
DS51331A_JP-page  2  2004 Microchip Technology Inc.
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インサーキットデバガ ---Microchip インサーキットデバッガの
情報で、MPLAB ICD と MPLAB ICD 2 を含みます。

MPLAB IDE ---Microchip MPLAB IDE(Windows® Integrated 
Development Environment for development systems tools) に関す
る情報。MPLAB IDE, MPLAB SIM シミュレータ , MPLAB IDE 
プロジェクトマネージャ、エディター、デバッグ機能などを
フォーカスしています。

プログラマー ---Microchip PICmicro® MCU デバイスプログラ
マー に関する情報で、PRO MATE®II デバイスプログラマー、 
PICSTART® Plus 開発用プログラマを含みます。

連絡先情報

Microchip 製品サポートは以下のいずれから受けられます。

• 代理店

• 地域販売オフィス --- 販売オフィスの場所は本ガイドの終わ
りに記載されています。

• フィールドアプリケーションエンジニア (FAE)
• コーポレートアプリケーションエンジニア (CAE)へのコンタ
クトは (480) 792-7627 から可能です。

• ホットライン

システム情報とアップグレードラインでは Microchip 開発システ
ムのソフトウエア製品に関する最新版リストを提供しています。
また、アップグレードキットの入手方法についても提供してい
ます。

ホットラインの電話番号は

1-800-755-2345：米国とカナダの殆どの地域

1-480-792-7302：上記以外の世界中の地域。
 2004 Microchip Technology Inc. DS51331A_JP-page  3



MPLAB® ICD 2 ユーザーズガイド

newICD2_UG.book  Page 4  Thursday, January 6, 2005  3:38 PM
NOTES:
DS51331A_JP-page  4  2004 Microchip Technology Inc.



MPLAB® ICD 2  

newICD2_UG.book  Page 5  Thursday, January 6, 2005  3:38 PM
第 1 章 MPLAB ICD 2 の動作

ユーザーズガイド
1.1 序章

この章では、MPLAB ICD 2 の動作について簡単に説明します。
この目的は、プログラミングやデバッグ作業のために、ター
ゲットボードが MPLAB ICD 2 に接続できるように設計するため
の十分な情報をあたえるためです。プログラミングやインサー
キットデバッグの基本理論については、もし問題が発生した場
合に、迅速に解決できるように説明されています。

1.2 ハイライト

この章ではまず MPLAB ICD 2 の概略について述べ、次に
MPLAB ICD 2 のプログラミングモード、デバッグモードについ
て述べます。 以下の内容がカバーされています。

• ICD と ICE
･ モジュラーインターフェース接続

･ デバッグモード

･ デバッグモードの要求事項

･ デバッグ用に確保されるリソース

･ プログラムモード
 2004 Microchip Technology Inc. DS51331A_JP-page  5
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1.3 ICD vs. ICE
インサーキットデバッガ (ICD) はインサーキットエミュレータ 
(ICE) より低価格で、ICE の代替として使用できます。以前なら
より高価なハードでしか実現できなかった多くのことを ICD で
は実現できますが、そのコストメリットは ICE が持ついくつか
の便利な機能との相殺（trade-off）により実現しています。ユー
ザーは ICD コンパチブルのアプリケーションを設計すれば低価
格のハードウエアデバッガの利益を享受できます。

ICE に対して、インサーキットデバッガに要求されるものとして
以下のものがあります。

･ インサーキットデバッガは、ターゲットデバイスの一部の
ハードウェア、ソフトウェアリソースを占有します。

• ターゲットPICmicro MCU に動作クロックを提供しなければ
いけません。

• ICD は、ターゲットシステムとの接続が完全に動作している
時のみデバッグ可能となります。

エミュレータはメモリとクロックを備え、ターゲットアプリ
ケーションボードに接続されていなくてもコードの実行が可能
です。開発 / デバッグのサイクルにおいては、ICE はシステム
が動作するためのパワーを供給できますが、ICD はアプリケー
ションシステムが動作しなければ、全くデバッグはできません。
一方、ICD コネクタはアプリケーションボードに配置され、シ
ステムが量産段階に入っても ICD との接続が取ることができ、
アプリケーションの簡易テスト、デバッグ、プログラミングが
可能になります。たとえ ICD が ICE に対していくつかの欠点が
あったとしても、このような状況では以下のような圧倒的な利
点を持っています。

• 量産ステージに入った後でもアプリケーションシステムとの
接続がはかれることにより、ICE プローブを挿入するために
マイクロコントローラの引き出しをする必要がありません。

• ICD は、その他の接続や装置無しにターゲットアプリケー
ションのファームウエアを再プログラム可能です。
DS51331A_JP-page  6  2004 Microchip Technology Inc.
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1.4 モジュラーインターフェース接続

MPLAB ICD 2 はターゲットとなる PICmicro MCU とは 6 極のモ
ジュラーインターフェースケーブルで接続されます。MPLAB 
ICD 2 コネクタのピン番号は図 1-1 に示すように、ターゲット PC
ボードの裏面に示されています。 

図 1-1： モジュラーコネクタのピン番号

注： ICE はターゲットマイクロコントローラをエミュ
レーションするためにカスタムハードウエアを使用
します。ICD は ICE の機能の一部を動作させるた
めにターゲットマイクロコントローラ上のハードウ
エアを使用します。また、ICD は ICE の様な機能
を動作させるためにターゲットマイクロコントロー
ラ上でソフトを動作させますが、その結果、通信の
ために、ターゲットマイクロコントローラのメモリ
領域の一部、CPU 制御、スタック領域、入出力ピ
ンをリソースとして使用します。

注： ICD ケーブルはおのおのの端からミラーイメージ接
続になり、MPLAB ICD 2 との接続では以下に示す
とおり反対の接続になります。

ターゲット 
PCボード 
裏面 

MPLAB ICD2 
コネクタ 
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図 1-2 に MPLAB ICD 2 とターゲットボード上のモジュラーコネ
クタとの接続図を示します。ICD コネクタには 6 本のピンがあ
りますが、5 本分のピンのみ使用されています。図にはコネク
タからターゲット PC ボード上の PICmicro MCU デバイスへの
配線も示されています。PICmicro MCU リセット時に配線をロ
ウへストローブされるように、VPP/MCLR ラインをプルアップ
抵抗 ( 通常約 10k オーム )を用いて VDD に接続することを推奨
します。  

図 1-2： ターゲットボードと MPLAB ICD 2 の接続ｱ

アプリケーション 
PCボード

MPLABICD2インターフェース

コネクタ 

ユーザリセット 
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Pin 2 (VDD) はある条件のもとではターゲットアプリケーション
ボードに一定量の電源を供給しますが、本章説明のためには、
pin 2 と 3 (VSS) は省略されています。Pin 2 と 3 は図には示されて
いますが、以下の説明では、VPP/MCLR, PGC, PGD の 3 信号の
みの動作について説明します。

必ずしもすべての PICmicro MCU が AVDD や AVSS ラインを
もっているわけではありませんが、ターゲットの PICmicro 
MCU に AVDD や AVSS が存在するなら、MPLAB ICD 2 が正常に
動作するためにそれらは適切に接続されねばなりません。

外部接続は大変シンプルであり、これまでに経験した問題のほ
とんどは、MPLAB ICD 2 の動作を妨げるこれらの信号線と繋
がっているほかの接続や部品に起因するものです。詳細は 1.4.1
で説明します。

注： 以下の説明では、VDD は無視されています。しか
し、ターゲットボードの VDD は MPLAB ICD 2 上の
出力ドライバに電源供給するために使用されること
を注意してください。これにより、ターゲットボー
ドが低電圧で動作する場合のレベル変換が可能とな
ります。電源は MPLAB ICD 2 からターゲットに供
給するか、ターゲット独自の電源から供給されるか
に関わらず、もし MPLAB ICD 2 の VDD ライン 
(ICD connector の pin 2) に電圧がなければ、
MPLAB ICD 2 は動作しません。 
 2004 Microchip Technology Inc. DS51331A_JP-page  9
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1.4.1 MPLAB ICD 2 の動作を妨げるような回路

図 1-3 は MPLAB ICD 2 の動作を妨げるようなライン上の部品使
用例を示します。 

図 1-3： 不適切な回路部品使用

特に以下のガイドラインには従わなければなりません。

• PGC/PGD ラインはプルアップしてはなりません。PGC/
PGD ラインは、MPLAB ICD 2 内に 4.7K オームのプルダウ
ン抵抗でロウレベルに接続されているので、電圧レベルを分
割することになります。

• PGC/PGD ラインにキャパシターをつけてはなりません。プ
ログラミングやデバッグの通信時に、データとクロックの高
速遷移を妨げることになります。

• MCLR ラインにキャパシターをつけてはなりません。VPP の
高速遷移を妨げることになります。簡単なプルアップ抵抗で
十分です。 

• PGC/PGD ラインにダイオードをつけてはなりません。
MPLAB ICD 2 とターゲット PICmicro MCU 間の双方向 通信
が妨げられることになります。

No!

No!

No!
No!

VPP/MCLR

PGC

PGD

1

5

4
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1.5 デバッグモード

MPLAB ICD 2 をデバッガとして使用するには２つのステップが
必要です。第一にアプリケーションプログラムがターゲット
PICmicro MCU にプログラムされていること。次にターゲット
FLASH PICmicro MCU のインサーキットデバッグハードを用い
てアプリケーションプログラムを実行・テストすることです。
この２つのステップは、MPLAB IDE 動作と直接関連していま
す。

1. プログラムコードをターゲットにプログラムします。

2. デバッガを用いてブレークポイントを設定し、プログラム
を実行させます。

もしターゲット PICmicro MCU が正しくプログラムされていな
いと、MPLAB ICD 2 ではデバッグできません。 
図 1-4 はプログラミングに必要な基本接続を示しています。こ
れは図 1-2 と同様であることに注意してください。但し、見や
すくするために、MPLAB ICD 2 からの VDD と VSS ラインは表
示されていません。

図 1-4： プログラミング用の適切な接続 

+5V

Programming

4.7KΩ

4.7KΩ

VPP/MCLR

PGC

PGD

1

5

4

MPLAB ICD 2
Internal Circuits

VSS

VDD
Voltage
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MPLAB ICD 2 に内蔵されているインターフェース回路のうちい
くつかの簡略図を示します。プログラミングのためには、ター
ゲット PICmicro MCU へのクロック供給は不要ですが、電源供
給は必要です。プログラミング時に MPLAB ICD 2 は、VPP にプ
ログラミングレベルを供給し、PGC にクロックパルスを PGD
にシリアルデータを供給します。正しくプログラムされたかど
うかを確認するには、PGC にクロックを供給し、PGD から
データを読み出します。この動作は、PICmicro MCU の ICSP™
プロトコルに一しています。

1.6  デバッグモード時の必要事項
MPLAB ICD 2 を用いてデバッグ(ブレークポイントの設定、レジ
スタの中身を見る等 )するには、正しく動作していなければい
けない重要事項があります。

• MPLAB ICD 2 は PC に接続されていなければなりません。また
外部電源もしくは USB ケーブル経由で PC から電源が供給さ
れていなければなりませんし、RS-232 もしくは USB ケーブ
ルで MPLAB IDE と通信できなければなりません。詳細につい
てはオンラインヘルプをご参照ください。  

• MPLAB ICD 2 はモジュラーインターフェースケーブル（もし
くは相当品）によって、ターゲットの PICmicro MCU の VPP, 
PGC, PGD ピンに接続されねばなりません。また、VSS と VDD
も MPLAB ICD 2 とターゲットの PICmicro MCU 間で接続され
ねば　なりません。

• ターゲットPICmicro MCUは電源と発振可能の発振器を持た　
ねばなりません。ターゲット PICmicro MCU が、理由のいか
んにかかわらず、動作しなければ MPLAB ICD 2 はデバッグ機
能を　実行できません。

• ターゲット PICmicro MCU は、そのコンフィギュレーション
ワードを正確にプログラムされねばなりません。 
- 発振器コンフィギュレーションビットは、ターゲットデザイン
に依存して、RC, XT, RC, 等に対応せねばなりません。 

- ターゲット PICmicro MCU では、ウオッチドッグタイマを有効
にしてはいけません。 

- ターゲットでは、コードプロテクションを有効にしてはいけま
せん。

- ターゲットではテーブルリードプロテクションを有効にしては
いけません。
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1.6.1 デバッグモードに入るための動作手順

上記条件があえば、MPLAB ICD 2 がデバッガモードに設定され
ているとき (Debugger>Select Tool) に、これらの動作は実行可
能です。 
• Debugger>Program が選択されている時、上記に示される

ICSP プロトコルにより、アプリケーションコードが
PICmicro MCU のメモリに　プログラムされます。 

• 小さな"デバッグイグゼクティブ"プログラムは、ター　ゲッ
ト PICmicro MCU のプログラムメモリの上位エリアに　格
納されます。デバッグイグゼクティブプログラムはプログラ
ム　メモリに常駐しなければならないので、アプリケー　
ションプログラムは、この予約空間 (上位エリア )を使用す
ることはできません。デバッグエグゼクティブプログラム
は、一般に 0x120 ワードのプログラムメモリ領域を必要と
します。 

• ターゲットの PICmicro MCU にある、特別の “in-circuit 
debug” レジスタが有効にされます。これにより、デバッグ
エグゼクティブプログラムは MPLAB ICD 2 により起動　さ
れます。 

• ターゲットの PICmicro MCU は、VPP/MCLR ラインがロウに
されている間、リセット状態に保たれています。
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1.6.2 デバッグモードの詳細

図 1-5 は MPLAB ICD 2 がデバッグできる状態を図示していま
す。 

図 1-5：  デバッグできる状態の MPLAB ICD 2

アプリケーションプログラムが正しく動作するか否かを検証す
るには、プログラムコードにブレークポイントを初期の段階で
設定します。ブレークポイントが、MPLAB IDE のユーザイン
ターフェースから設定された場合、ブレークポイントアドレス
は、ターゲット PICmicro MCU 内のデバッグレジスタに格納さ
れます。PGC と PGD を通してコマンドは、ブレークポイント
アドレス設定用レジスタに直接交信します。

次に、通常 Debugger>Run 機能もしくは Run アイコン ( 前進矢
印 )は MPLAB IDE の中で押されます。MPLAB ICD 2 は VPP/
MCLR ラインのレベルを上げ、ターゲットを実行させます。
ターゲットは アドレス０（ゼロ）からスタートし、プログラム
カウンタが、内蔵デバッグレジスタに事前に格納されたブレー
クポイントアドレスに達するまで動作を実行します。
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ブレークポイントアドレスの命令が実行された後、ターゲット
PICmicro MCU のインサーキットデバッグ機構が動作を始め、

（割り込み処理の様に）PICmicro MCU のプログラムカウンタ値
をデバッグイグゼクティブプログラムに転送し、ユーザアプリ
ケーションプログラムは中断されます。MPLAB ICD 2 は、PGC 
と PGD を通してデバッグイグゼクティブプログラムと通信を行
い、ブレークポイントの状態を入手し、それを MPLAB IDE に返
送します。MPLAB IDE は、MPLAB ICD 2 に一連の質問要求を
出し、ターゲット PICmicro MCU に関する情報（ファイルレジ
スタの内容や CPU の状態）を入手します。これらの質問要求
は、最終的にはデバッグイグゼクティブプログラムにより実行
されます。

デバッグイグゼクティブプログラムはプログラムメモリ内で、
アプリケーションプログラムのように実行されます。それは、
ハードウエアスタック（通常は一つか二つ）を使用し、典型的
には、一時変数用として 14 のファイルレジスタを使用します。
もし、PICmicro MCU が、発振器がない、電源が供給されない、
ターゲットボード上の回路がショートしている等如何なる理由
であれ、動作していなければ、デバッグ上位機構は MPLAB 
ICD 2 と通信できませんので、MPLAB はエラーメッセージを発
行します。  
ブレークポイントを入手する別の方法は、MPLAB IDE の “Halt”
ボタン（Run 矢印の右にある “pause” シンボル）を押すことで
す。これにより、ターゲット PICmicro MCU のインサーキット
デバッグ機構が、プログラムカウンタをプログラムメモリ内の
ユーザコードからデバッグイグゼクティブに切替えるように、
PGC と PGD ラインを切替えます。再び、ターゲットアプリケー
ションプログラムは停止し、MPLAB IDE は MPLAB ICD 2 とデ
バッグエグゼクティブの通信機能を用い、ターゲット PICmicro 
MCU の状態をリクエストします。
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1.7 デバッグ用予約リソース

MPLAB ICD 2 で開発する場合には、デバッグ用に予約されてい
るデバイスリソースに注意しなければなりません。使用されて
いるプロセッサの詳細を見るには、MPLAB IDE オンラインヘル
プか、もしくは使用ソフトの README ファイルをチェックして
ください。一般的には、インサーキットデバッグ時には、以下
に示すような、チップ内のリソースを使用します。

• MCLR/VPP はプログラミング用に共有されます。

• Low-voltage programming (LVP) は使用できません。

• PGC と PGD はプログラミングとインサーキットデバッグ　
用に予約されます。

• 一つまたは二つのスタックが MPLAB ICD 2 デバッガ　で使
用されます。 

• いくつかの汎用レジスタファイルが予約されています。

• プログラムメモリ空間のうち上位ワードはデバッグイグゼク
ティグコードのために予約されています。

• デバッグ時は、PIC18FXXXX MCU のシャドウスタックは使
用できません。アプリケーションプログラムはシャドウス
タックを使用できますが、ブレークポイントを取り込む時に
ICD がシャドウスタックを上書きするので、ファースト割り
込みもしくはファースト CALL ルーチンから戻る場合のデ
バッグはできません。
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1.8 プログラマモード

デバイスをプログラムするために Programmer>Program を選択
した場合は、インサーキットデバッグレジスタは MPLAB IDE で
無効にされ、MPLAB ICD 2 はターゲットアプリケーションコー
ドとコンフィグレーションビット（それと EEPROM がインス
トールされ選択されていれば EEPROM データも）のみをター
ゲット PICmicro MCU にプログラムします。デバッグイグゼク
ティブはロードされません。このモードでは、MPLAB ICD 2 は
ターゲットのリセット /スタートを行うために MCLR ラインを
トグルできるのみです。ブレークポイントは設定できず、レジ
スタの内容を見たり変更したりすることはできません。

MPLAB ICD 2 は ICSP を用いてターゲットをプログラムします。
プログラミング中はクロックは不要で、コードプロテクト、ウ
オッチドッグタイマイネーブル、テーブル読出しプロテクトを
含め、プロセッサのすべてのモードのプログラムが可能です。  

注： MPLAB ICD 2 でピン数の少ないデバイスをデバッ

グする際には、ヘッダボードが必要です。それらの
部品は、前に説明されたように、VPP, PGC, PGD
を接続することでヘッダ無しでプログラムできま
す。
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NOTES:
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第 2 章  開始にあたり

ユーザーズガイド
2.1 序章

この章では、MPLAB IDE ソフトウエアと MPLAB ICD 2 の使い
方、および電源の説明と推奨電源立上げシーケンスを説明しま
す。第 3 章は、MPLAB ICD 2 を用いて、ステップバイステップ
でチュートリアルを行います。チュートリアルを進める前に、
ソフトウエアとハードウエアに関しては、本章の 2.3 から 2.5
に沿って構成されていることに留意ください。 

2.2 ハイライト

本章でカバーされている項目は下記の通りです。

• MPLAB ICD 2 のシステム要素

• MPLAB ICD 2 用に MPLAB IDE のインストールとコンフィ
ギュレーション

･ 電源の供給

･ 環境設定の概要

• MPLAB ICD 2 開発手順の概要

2.3 MPLAB ICD 2 のシステム要素 
MPLAB ICD 2 モジュールに加えて、以下のものが必要です。

• MPLAB ICD 2を制御するＰＣにインストールされたMPLAB 
IDE ソフト (version 6.20 以降 )

• RS-232 もしくは USB ケーブル - MPLAB ICD 2 モジュール
を　PC の COM ポートもしくは USB ポートに接続するた
めに使います。
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• モジュラーインターフェースケーブル ---- MPLAB ICD 2
モジュールをデモボードもしくはユーザアプリケーション
ボードに接続するために使用します。 

• デモボードもしくはターゲットアプリケーションボード --- 
デバッグ機能をインストールした PICmicro MCU と　モ
ジュラー　インターフェース（そして MPLAB ICD 2）に接
続する　ために使用します。MPLAB IDE から MPLAB ICD 2
への　シリアルもしくは USB 通信のためには、ターゲット
との接続なしでできますが、ターゲットとの接続なしでは、
MPLAB ICD 2 は、デバッガとしては動作しません。 

• 電源アダプタ　---- MPLAB ICD 2 とターゲットアプリ　
ケーションボードに電源を供給するために使用します。

2.4 MPLAB ICD 2 用の MPLAB IDE のインストー
ルとコンフィギュレーション

MPLAB IDE ソフトをインストールするには、まず最新版の
MPLAB IDE インストール用ソフト (MP6xxxx.exe, ここで 
6xxxx はMPLAB IDE のバージョンを示します)を、Microchipウ
エブサイト (www.microchip.com) もしくは MPLAB IDE CD-
ROM (DS51123) から入手してください。 

2.4.1 通信部の設定

MPLAB IDE が示す手順に従い、MPLAB IDE の下にある Driv-
ersXXフォルダから USB ドライバソフトをインストールして下
さい。第 4 章の "USB インストールの詳細 " を参照してくださ
い。 

RS-232 ケーブルを使用する場合は、ケーブルを MPLAB ICD 2 と
PC に接続してください。

注： MPLAB IDE ソフトをインストールし、USB ドライ
バソフトの設定が完了してから USB ケーブルを接

続してください。

注： USB ケーブルを使う際には、MPLAB IDE ソフトを

インストールしてから接続してください。
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2.4.2 MPLAB IDE の起動

MPLAB IDE ソフトウエアをインストールした後、以下のどれか
の方法で起動してください。

• Start>Programs>Microchip MPLAB IDE>MPLAB IDE を選択
してください。

• MPLAB IDE のデスクトップアイコンをダブルクリック　し
てください。

• MPLAB IDE インストールディレクトリの \dllsサブディレ
クトリにある mplab.exeを実行します。  .

MPLAB IDE 起動後、MPLAB ICD 2 を使用するために以下の設定
が必要です。

1. MPLAB ICD 2 でサポートされている PICmicro を選択しま
す。 

2. MPLAB ICD 2 をカレントデバッガに設定します。 
3. MPLAB ICD 2 を RS-232 もしくは USB インターフェース

モードに設定します。

注： USB ケーブルと RS-232 ケーブルの両方を MPLAB 
ICD 2 に接続しないでください。

注： MPLAB IDE ソフトウエア使用にあたり、より詳細
については以下を参照ください。 
-“MPLAB v6.xx クイックスタート ,” DS51281
- MPLAB IDE のオンラインヘルプ

-MPLAB IDE インストールディレクトリに含ま
れる Readme for MPLAB IDE.txt

-MPLAB ICD 2 に関する最新の情報については
Readme for MPLAB ICD 2.txtを参照くだ
さい。
 2004 Microchip Technology Inc. DS51331A_JP-page  21



MPLAB® ICD 2 ユーザーズガイド

newICD2_UG.book  Page 22  Thursday, January 6, 2005  3:38 PM
2.4.3 デバイス選択

MPLAB ICD 2 でデバッグされるべきデバイスを選択するにはを
デバイス選択 dialog (Configure>Select Device) を使用します。
MPLAB ICD 2 でサポートされるデバイスは、Microchip Tool Sup-
port の下の MPLAB ICD 2 の隣にある緑色のアイコンで示されま
す。サポートされないデバイスは赤色のアイコンで示されます。
黄色のアイコンは、一部デバイスは選択可能ですが、制限事項
がある場合があり、量産用途としては不適ですが、MPLAB ICD 
2 で暫定用途としてリリースされていることを示します。

2.4.4 MPLAB ICD 2 をデバッグツールとして設定

MPLAB ICD 2 をデバッグツールとして選択するには、Debug-
ger>Select Tool>MPLAB ICD 2 を選択します。デバッガメニュー
と MPLAB IDE のツールバーは、ツールが選択されると、デバッ
グオプション表示に切替わります。また、出力ウインドウが開
き、 ICD の状態と通信に関するメッセージが MPLAB ICD 2 タブ
上に表示されます。 

2.4.5 インターフェースの設定

USBインターフェースもしくはRS-232通信の正しいCOMポート
を選択するには Debugger>Settings 通信タブで選択してくださ
い。

注： MPLAB ICD 2 はデバッグツール (Debugger Menu) 、
もしくはプログラマモード (Programmer menu) の
どちらかが選択可能です。両方同時に選択しないで
下さい。
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2.5 電源の供給

MPLAB ICD 2 やターゲットボードへの電源供給には多くの構成
あります。設定の基本構成を下記に示します。

• USB 接続を使用する場合、MPLAB ICD 2 は PCからの　電源供
給が可能ですが、ターゲットボードへは個別の電源から供給
を行ってください。

• RS-232 で PC への接続を行う場合、MPLAB ICD 2 は個別の 電
源からの供給が必要です。 

• MPLAB ICD 2 が個別の電源を持っている場合、小さな　ター
ゲットボード用として、5 ボルト、最大 200 mA までの供給が
可能です。 

• MPLAB ICD 2 はターゲットボードからの電源供給は　できま
せん。

• MPLAB ICD 2 への電源供給は、ターゲットボードへの　電源
供給より前に行ってください。

2.5.1 MPLAB ICD 2 がターゲットボードに電源供給す

る場合の電源立上げシーケンス

MPLAB ICD 2 からターゲットボードに電源供給する場合に以下
のシーケンスを使用します。この構成の場合には、5 ボルト、
最大 200 mA の電源のみが供給できます。

1. MPLAB ICD 2 に電源を供給します。ターゲットボードには
電源供給しないで下さい。

2. MPLAB IDE 6.xx をスタートします。

3. MPLAB IDE のデバッガメニューで、Connect を選択します。

4. MPLAB ICD 2 との通信を確立した後に、Debugger>Settings
を選択します。

5. Settings ダイアログで、Power タブをクリックし、“Power 
target circuit from MPLAB ICD 2” のチェックボックスが
チェックされたことを確認します。OK をクリックします。.

注： もし Settings ダイアログの Status タブのセルフテス

トが一つでもパスしない場合は、チップの消去・プログ

ラムができません。この場合には、さらにトラブル

シューティングを行ってください。詳細については、第
5 章・第 6 章もしくはオンラインヘルプをご覧下さい。 
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2.5.2 ターゲットボードが独立した供給電源を持つ場
合の電源電源立上げシーケンス

ターゲットボードが独立した供給電源を持つ場合に以下のシー
ケンスを使用します。この構成では、2-5 ボルトかつ MPLAB 
ICD 2 から供給されるよりも多くの電流 (>200 mA) を供給可能で
す。使用するデバイスに関しての動作電源範囲を PICmicro 
MCU データシートで確認してください。

1. MPLAB ICD 2 に電源を供給します。ターゲットボードには
電源供給しないで下さい。

2. MPLAB IDE 6.xx をスタートします。

3. MPLAB IDE のデバッガメニューで、Connect を選択しま
す。

4. MPLAB ICD 2 との通信を確立した後に、Debugger>Set-
tings を選択します。

5. Settings ダイアログで、Power タブをクリックし、 “Power 
target circuit from MPLAB ICD 2” のチェックボックスが
チェックされていないことを確認します。OK をクリック
します。 

6. ターゲットボードの電源を供給し、それから
Debugger>Connect を選択します。

注： もし Settings ダイアログの Status タブのセルフテ

ストが一つでもパスしない場合は、チップの消去・
プログラムができません。この場合には、さらにト
ラブルシューティングを行ってください。詳細につ
いては、第 5 章・第 6 章もしくはオンラインヘル
プをご覧下さい。
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2.6 環境設定の概要

本章の残りの部分では、MPLAB ICD 2 使用方法の概要（機能と
メニュー）について説明します。このセクションでは、MPLAB 
ICD 2 の動作についての簡単なまとめを説明します。

2.6.1 デバッグオプションとプログラムオプションの
設定

種々のダイアログによりデバッグオプションとプログラムオプ
ションを設定可能です。

• コンフィギュレーションビットダイアログ (Configure>Con-
figuration Bits) - 本ダイアログは PICmicro プロセッサのコン
フィギュレーションビットを　選択します。　このオプショ
ンの詳細については、デバイスデータシートの中の Special 
Features – Configuration Bits セクションをご参照ください。 

• プログラムタブ、ICD Settings dialog (Debugger>Settings or 
Programmer>Settings) は、プログラムオプション (Select 
Memories, Program and External Memory Ranges, ID, and 
Program Options, Erase All) を設定します。もし ID ビットの
プログラミングが必要なら、Configure>ID Memory dialog
で値を設定します。

• パワータブ、ICD Settings dialog (Debugger>Settings or 
Programmer>Settings) は、MPLAB ICD 2 とターゲットボー
ドの電源電圧をチェックし、電源が MPLAB ICD 2(5V, 最大
200mA)に接続されている場合は、 “Power the target from the 
MPLAB ICD 2” を選択します。

注： コンフィギュレーションビットはダイアログで設定

する以外にもソースコードで設定可能です。それを
行うと、プロジェクトが再構築される毎にコンフィ
ギュレーションビットは　ソース　コードで設定さ
れる値にリセットされます。
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• ステータスタブ、ICD Settings dialog (Debugger>Settings or 
Programmer>Settings)--- スタートアップ時の自動接続以外
に、このダイアログでは出力メッセージをファイルに取り込
めるよう設定できまこのメッセージはエラーを見つける際
に、ユーザもしくは、必要な場合には、Microchip テクニカ
ルサポートの手助けになります。

2.6.2 プロジェクトの作成

新しいプロジェクトを作成する簡単な方法は、Project>Project 
Wizard を選択することです。プロジェクト ウイザードにより新
しいプロジェクトとそのプロジェクトを構築するための言語
ツールが生成されます。このウイザードは、ソースファイルや
ライブラリ、リンカスクリプトを、プロジェクトウインドウ上
の種々のノードに追加する際のガイドを行います。第 3 章の
チュートリアルでは、このウイザードを使用する場合の詳細に
ついて説明されます。 

2.6.3 プロジェクトの構築

プロジェクト作成後、アプリケーションの構築のために
Project>Build All を選択します。これにより、MPLAB ICD 2 で
ターゲットボードにプログラムされるアプリケーションプログ
ラムのオブジェクトコードが生成されます。 

2.7 MPLAB ICD 2 開発手順の概要

MPLAB ICD 2 による開発手順は以下の４つのステップから成り
ます。

1. MPLAB ICD 2 をデバッグツールとして用いることで、ター
ゲットアプリケーションボードにアプリケーションコード
をプログラムします。

2. アプリケーションプログラムをデバッグします。

3. ソースコードの修正とプロジェクトの再構築、これをアプ
リケーションプログラムが設計どおりに動作するまで繰り
返します。

4. MPLAB ICD 2 をプログラマモードとして選択し、ターゲッ
トアプリケーションボード上のデバイスをプログラムしま
す。
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2.7.1 ターゲットプロセッサをデバッグ用にプログラ
ムする

デバッグ用として MPLAB ICD 2 にアプリケーションプロジェク
トコードをプログラムするには、以下のステップを行ってくだ
さい。

1. Debugger>Settings を選択し、その後アプリケーションプログ
ラム用プログラムメモリの開始 /終了アドレスを設定するため
に、Program タブをクリックします。 

2. Configure>Configuration Bits を選択し、ターゲットボードに適
したコンフィギュレーションビットの設定を行います。 

3. Debugger>Program を選択します。

2.7.2 アプリケーションプログラムのデバッグ

コードをリアルタイムで実行するには、

1. ソースファイルを開く（Project ウインドウのファイル名をダブ
ルクリックするか、File>Open を使用します）、もしくは、プロ
グラムメモリウインドウを開きます (View>Program Memory) 。

2. Debugger>Run を選択します。（もしくは、ツールバーの Run ボ
タンをクリックします。） 

プロセッサはブレークポイントに達するか、プロセッサが
Debugger>Halt により（もしくはツールバーの Halt ボタンをク
リックすることにより）中断されるまで動作します。

ブレークポイントの位置を設定するには、Debugger>Break-
points を選択します。もしくは、ブレークポイントを設定したい
場所のソースコードまたはプログラムメモリの位置を右クリッ
クし、Set Break Point を選択します。MPLAB ICD 2 では一度に
一つのブレークポイントのみ設定可能です。

プロセッサが中断した後、コードはステップモードで実行でき
ます。一行単位でコードを実行するには、Debugger>Step Into を
選択（もしくはツールバーの Step Into ボタンをクリック）しま
す。プロセッサはステップ毎に中断します。

注： シングルステップ実行時には、割り込みは使用できま
せん。したがって、割り込みルーチンには入りませ
ん。ブレークポイントを割り込みルーチンの内部で設
定すれば、割り込みコード経由でシングルステップに
入ることができます。
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2.7.3 ターゲットアプリケーションコードの修正と
HEX ファイルの再生成

コードを修正し、HEX ファイルを再生成するには以下のステッ
プを実行します。

1. ソースファイルを開きます（Project ウインドウのファイ
ル名をダブルクリックするか、File>Open を使用します）。

2. コードのデバッグのために必要な修正を行います。

3. Project>Build All を用いて HEX ファイルの再生成を行いま
す。

4. Debugger>Program を選択し、アップデートされた HEX
ファイルをデバイスにプログラムします。

2.7.4 アプリケーションプログラムの終了：MPLAB 
ICD 2 をプログラマーとして使用

ユーザがコードのデバッグを終了し、要求どおりに実行するア
プリケーションプログラムが完成したら、デバッガを無効にし、
デバイスをプログラムすることができます。ICD の動作用に確
保されていたデバイスリソースはその他の用途に開放されます。 

まず、Debugger>Select Tool メニューからデバッガに “None” を
設定します。

次に、Programmer>Select Programmer>MPLAB ICD 2 を選択
し、MPLAB ICD 2 をプログラマモードに選択します。プログラ
マメニューと MPLAB IDE ツールバーは、ツールが選択されると
プログラマオプションの表示に変わります。また、出力ウイン
ドウが開き、ICD 状態や通信に関するメッセージが MPLAB 
ICD 2 タブ上に表示されます。

注： MPLAB ICD 2 はデバッグツールモードもしくは 
programmer モードのどちらかのみ選択可能です。
同時に両方を選択しないで下さい。
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プロジェクトはここで再構築され、すべてのデバッグモードは
使用不可になりソースコードで定められるコンフィギュレー
ションビットがターゲットボードにプログラムされます。

プログラムオプション（メモリ領域やその範囲）は Program-
mer>Settings ダイアログのプログラムタブ上に設定できます。

コンフィギュレーションビットはソースコードファイルで定め
られる通りに設定されます。Configuration>Configuration Bits ダ
イアログを用いることで手動でも選択できます。 
必要であれば、Configure>ID Memory を選択することで、ID
ビットも設定可能です。
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NOTES:
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第 3 章 MPLAB ICD 2 チュートリアル

ユーザーズガイド
3.1 序章

このチュートリアルでは、MPLAB IDE がインストールされてい
るフォルダにあるサンプルプログラム（TUT452.asm）を用い
て簡単なプロジェクトを開発する過程を一通り実施します。こ
のプログラムは PICDEM 2 Plus デモボード (DM163022) を用
いて、 PIC18F452 アナログデジタル (A/D) コンバータを実装・
動作させます。このプログラムは、デモボードのポテンション
メータに接続された A/D チャンネル 0 からの入力を変換する 
A/D モジュールを制御し、変換結果を４つの PORTB LED 
(RB3:RB0) に表示します。 

3.2 ハイライト

この章でカバーされるトピックスは以下の通りです。

• 環境の設定

• プロジェクトウイザードを実行

• プロジェクトを見る

• HEX ファイルの生成

• デバッグオプションの設定

• デモボードの立上げ

• デバッグ用プログラムコードのロード

• TUT452 の実行

• TUT452 のデバッグ

• アプリケーションのプログラミング

• TUT452 メインルーチンとソースコード
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3.3 環境設定

このチュートリアルを開始する前に、第 2 章 “MPLAB IDE の開
始にあたり ” の 2.3 から 2.5 に従って、ハードウエアと MPLAB 
IDE のソフトウエアを設定してください。このチュートリアルで
使用される初期設定のいくつかは、第 2 章で設定された結果を
そのまま使用しています。 
起動すると MPLAB IDE のデスクトップに図 3-1 のような画面が
現われます。

図 3-1： MPLAB IDE V6.XX
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3.3.1 デバイスの選択と開発モードの設定

このチュートリアル用にデバイスを設定するために、以下を実
施します。

1. Configure>Select Device を選択します。

2. デバイス選択ダイアログで、デバイスリストボックスの中
から PIC18F452 を選択します。Microchip ツールサポート
セクションにある MPLAB ICD 2 の隣にある “light” が緑色
になっているはずです。

3. OK をクリックします。

MPLAB ICD 2 をデバッガとして選択します。

1. Debugger>Select Tool>MPLAB ICD 2 を選択します。デ
バッガメニューはその他のデバッグオプションが利用でき
ることを示します。また、出力ウインドウが開き、接続情
報を表示します。

2. Debugger>Settings の通信タブを選択します。PC が使用し
ている USB もしくは COM ポート /ボーレートを選択し
ます。

3. もし MPLAB ICD 2 を自動接続したいのであれば、ステータ
スタブをクリックし、“Automatically connect at startup”

（起動時の自動設定）を選択します。メッセージレベルが
最小に設定されていることを確認します。

4. OK をクリックします。

5. MPLAB ICD 2 に接続するために、Debugger>Connect を選
択します。

注： もし MPLAB IDE が、起動時に MPLAB ICD 2 に接

続しようとしたが、USB ポートもしくは COM1 以
外の COM ポートが使用されていることにより、接
続に失敗したら、接続失敗のままとし、通信ポート
の設定のためにステップ 2 に進んでください。
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3.3.2 MPLAB ICD 2 の更新 
（オペレーションシステム）

MPLAB IDE のバージョンもしくは選択されたデバイスによって
は、ファームウエアの更新が必要との表示が現われる場合があ
ります。MPLAB IDE は自動的に新しいファームウエアをインス
トールします。

更新ダイアログが以下のように現われます。

図 3-2： MPLAB ICD 2 ファームウエア更新の DIALOG

また、異なった MPLAB ICD 2 ファームウエアが、異なった 
PICmicro MCU ファミリーに使用されるので、このダイアログは
異なった PICmicro MCU に切替わると現われます。

ファームウエアは以下のような手順に従い手動で変更できます。

1. Debugger>Download ICD2 Operating System を選択しま
す。ICD 2 選択ファームウエアファイルダイアログ (Select 
ICD 2 Firmware File dialog) が開きます。

2. リストからダウンロードするファームウエアファイルを選
択します。ファイルは icdxxxxxx.hexの形式を持ち、
ここで xxxxxxはバージョン番号をしめします。MPLAB 
IDEと一緒に供給される最新版の情報についてはREADME
ファイルもしくは MPLAB ICD 2.txtをご覧下さい。
バージョンは、選択された PICmicro デバイスによって変
わります。

3. Openをクリックします。MPLAB IDEがMPLAB ICD 2に新
しいオペレーションシステムをダウンロードします。
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3.4 プロジェクトウイザードの実行

このプロジェクトでは MPASM アセンブラが使用されます。

1. 最初のプロジェクトを立ち上げるために Project>Project 
Wizard を選択します。

2. ウィザードの次のダイアログに進みます。PIC18F452 を選
択します。

3. ウィザードの次のダイアログに進み,MPASMを言語ツール
として設定します。“Active Toolsuite” のプルダウンメ
ニューで、“Microchip MPASM Toolsuite” を選択します。
MPASM と MPLINK が、MPLAB IDE\MCHIP_Toolsフォル
ダ内の適切な実行形態として設定されていることを確認し
てください。MPASM は mpasmwin.exeを指し、
MPLINK は mplink.exeを指します。

図 3-3： ウイザードツール DIALOG
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次はプロジェクトファイルをウイザードに追加します。

なにか忘れた場合でも、ファイルは後で追加できます。ここの
例では、Browse を選択し MPLAB IDE がインストールされてい
るフォルダ（デフォルトフォルダは、ハードディスク上の
C:\Program Files\MPLAB IDE です。）に行きます、それか
ら MCHIP_Tools\Exampleに行き、TUT452.ASMを選択しま
す。

図 3-4： ウイザード追加ファイル

TUT452.ASMをクリックし、ハイライトします。それから
ADD>> をクリックし、右のウインドウに追加します。 
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このプロジェクトに必要な第二のファイルはリンカスクリプト
です。\LKRフォルダをクリックし展開します。それからスク
ロールし 18F452i.lkrを選択します。ファイル名が “i” を
持っていることを確認してください。 

図 3-5： ウイザード追加ファイル、リンカスクリプト

ADD>> を押し、リンカスクリプトを右のリストに移動します。
それが終わったら、Next をクリックします。ウイザードが終了
したら、図 3-6 のようなサマリスクリーンが表示されます。

図 3-6： ウイザード終了スクリーン
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3.5 プロジェクトを見る

ウイザードを終了後、MPLAB IDE デスクトップが再び表示され
ます。他のすべてのウインドウを閉じ、プロジェクトウインド
ウを観察してください。

プロジェクトウインドウは図 3-7 のように表示されます。

図 3-7： プロジェクトウインドウ

エラーが発生した場合は、ファイルは手動でプロジェクトウイ
ンドウに追加できます。“Source Files” ラインもしくは “Linker 
Scripts” ラインにカーソルを持っていき、ファイルを追加しま
す。ファイルを削除する場合、ファイル名をハイライトさせま
す。マウスの右ボタンをクリックしてメニューを出し、ファイ
ルを消去します。
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3.6 HEX ファイルの生成

デバッグ用に HEX ファイルを生成するには、Project>Build All 
を選択するか、プロジェクトウインドウ内のプロジェクト名を
右クリックしポップアップメニューから “Build All” を選択しま
す。MPASM アセンブラは、常にソース .asmファイルと同じ名
前を持った .hexを生成します。

出力ウインドウは図 3-8 の様に表示されます。

図 3-8： 出力ウインドウ

3.7 デバッグオプションの設定

3.7.1 構成ビット

デバイスにプログラムされるコンフィギュレーションビットを
設定するには、Configure>Configuration Bits を選択します。“Set-
tings” コラム内のテキストをクリックすると、これらは変更でき
ます。このチュートリアルでは以下のコンフィギュレーション
ビットを設定します。

• Oscillator - EC-OS2 as RA6（これは PICDEM 2 Plus 用の設
定であり、もし別のターゲットボードを用いる場合は、それ
に合うように変更します。）

• OSC Switch Enable - Disabled
• Power Up Timer - Enabled
• Brown Out Detect - Disabled
• Watchdog Timer - Disabled
• CCP2 Mux - RC1
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• Low Voltage Programming - Disabled
• Background Debug - Enabled( これによりインサーキットデ
バッガ機能が有効になります。MPLAB ICD 2 がカレントデ
バッガとして選択された場合、通常これは自動的に有効にな
ります。)

• Stack Overflow Reset - Disabled
• その他のコンフィギュレーションビットはすべてDisabledに
設定します。

3.7.2 プログラミングオプション

プログラミングオプションを設定するには、Debugger>Settings
を選択し、 Program タブをクリックします。

図 3-9： MPLAB ICD 2 の DIALOG と PROGRAM タブ 
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• PIC18FXX2 デバイスについては、チップがプログラムされ
るたびにすべてのメモリは消去されます。従って、 “Erase all 
before Program” は何も影響を与えません。

• Select Memories セクションでは “Program” をチェックし、　
“EEPROM” と “ID” はチェックしません。MPLAB ICD 2 をデ
バッガとして使用する場合には、コンフィギュレーション
ビットは常にプログラムされるため、Configuration ボック
スはチェックされますがグレーアウトされます。

• Program Memory Addresses (Start Address と End Address）
には、読出し、プログラム、ベリファイされるべきプログラ
ムメモリの範囲を設定します。Full Range をクリックする
と選択されたデバイスで使用できる最大プログラムメモリ領
域が設定されます。プログラムメモリ領域の最後は MPLAB 
ICD 2 デバッグエグゼクティブ用の領域になるように調整さ
れることに留意してください。MPLAB ICD 2 をデバッガと
して使用する際には、プログラムはこの上位リミットを越え
ることはできません。

3.8 デモボードの設定

デバッグの開始前に、PICDEM 2 Plus デモボードが以下のよう
に設定されているかどうか確認してください。

• EC OSC オプションが、　ジャンパ線 J7 を使って選択されて
いること。

• LED がジャンパ線 J6 を使って有効になっていること。

• 電源が供給されていること。
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3.9 デバッグ用にプログラムコードをロード

Debugger>Program を選択し、PICDEM 2 Plus デモボード上の
PIC18F452 に TUT452.hex をプログラムします。

プログラミングには数分かかります。プログラミング中は、出
力ダイアログの MPLAB ICD 2 タブは現在の動作状況を表示しま
す。プログラミングが終了したら、ダイアログは図 3-10 に様に
表示されます。

図 3-10： 現動作状態の表示

注： デバッグイグゼクティブコードは MPLAB ICD 2 デ
バッグ用として上位プログラムメモリ領域に自動的
にプログラムされます。デバッグコードは、MPLAB 
ICD 2 のインサーキットデバッグ機能を利用するため
に、ターゲット PICmicro MCU にプログラムされな
ければなりません。
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3.10 TUT452 の実行

MPLAB ICD 2 はリアルタイムで実行するか、ステップモードで
実行します。

• リアルタイム実行は、PICDEM 2 Plus デモボード上の
PIC18F452 が MPLAB IDE のランモード状態にあるときに実
行できます。

• ステップモードは、プロセッサが中断した後に実行できま
す。

これらのツールバーボタンはすばやくアクセスできるためにデ
バッグオプションで共通に使用されます。

リアルタイムモード開始方法

1. TUT452.asmを開きます。（プロジェクトウインドウ内の
ファイル名をダブルクリックするか、File>Open を使用しま
す。）

2. Debugger>Run を選択します。（もしくは Run ツールバーボ
タンをクリックします。）

3. デモボード上のポテンシャメーター (RA0) を回します。LED
の表示を観測します。プログラムが正確に動作してれば、
ポテンシャメーターの電圧値が２値表示で表示されること
が見えます。しかし、TUT452 プログラムにはバグがありま
す。3.11 にコードのデバッグ方法と修正方法の詳細が記載
されています。

4. プログラムの実行を停止するには、Debugger>Halt を選択し
ます。（もしくは Halt ツールバーボタンをクリックします。）

5. プログラムをリセットするには、Debugger>Reset を選択し
ます。

デバッガメニュー ツールバーボタン

Run

Halt

Step Into

Reset
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3.11 TUT452 のデバッグ

以下のことが一つでもあると、TUT452 プログラムは正常に動
作しません。

• A/Dコンバータの値が正しくPORTB (LED)に書き込まれてい
ない。

• A/D コンバータが動作していないか、変換動作設定がうまく
できていない。

• ソースコードにタイプミスがあり、プログラムが正しく動作
していない。

最初の可能性を検索するために、A/D 変換結果の値を PORTB
に書き込む行にブレークポイントを設定します。

1. TUT452.asmにある以下のラインをハイライトするか、
カーソルをもっていきます。

movwfPORTB;Write A/D result to PORTB

2. 右クリックし、ショートカットメニューを表示します。

3. ショートカットメニューから Set Break Point を選択しま
す。図 3-11 に示すように、このラインがブレークポイン
ト（B と赤表示）としてマークされます。

図 3-11：  ブレークポイントの設定
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4. Debugger>Run を選択（もしくは Run ツールバーボタンを
クリック）し、もう一度リアルタイムモードでプログラム
を実行させます。

ブレークポイントとしてマークされたラインをプログラムが
実行した時にプログラムは停止します。しかしサンプルプロ
グラムは中断しません。

5. Debugger>Halt を選択（もしくは Halt ツールバーボタンを
クリック）しプログラムを中断します。

ソースコードウインドウ内で、図 3-12（矢印の点）に示さ
れるように、サンプルプログラムは、ウエイトルーチン内の
2 ラインのうちの１つで中断します。

図 3-12： プログラム停止

中断位置とプログラムがブレークポイントまで到達していな
いことから、問題点は A/D 変換にあることがわかります。
A/D 変換終了フラグはセットされていません。A/D の初期設
定はこのプログラムの最初で行われます。

6. プログラムをリセットするには、Debugger>Reset を選択
します。最初の命令は緑色の矢印で示されます。
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7. プログラムの実行に伴い A/D レジスタの値がどのように変
わっていくかを見るために、新しいウオッチウインドウを
開きます。View>Watch を選択します。ウオッチダイアロ
グが開き、Watch_1 タブが選択されます。Add SFR の隣
のリストから “ADCON0” を選択します。そしてボタンを
クリックします。ADCON1 も同様に追加します。選択さ
れたシンボルは、図 3-13 に示されるようにウオッチウイ
ンドウに表示されます。 

図 3-13： ウオッチウインドウ

8. TUT452.asmソースコードで、スタート後、最初の命令に
ブレークポイントをセットします。TUT452.asmの clrf
PORTB;Clear PORTBのラインをハイライトするかカーソ
ルをもっていきます。

右クリックをしてショートカットを表示します。ショート
カットメニューから Set Break Point を選択します。このラ
インはブレークポイントとしてはマークされます。

9. Debugger>Run を選択（もしくは Run ツールバーボタンを
クリック）し、リアルタイムモードでプログラムを実行し
ます。

コードのブレークポイントラインを実行した後にプログラム
はストップし、ブレークポイント後の命令が図 3-14 に示す
ように表示されます。
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図 3-14： ブレーク後に中断したプログラム 

10. シングルステップを 5 回実行します。プログラムをシング
ルステップで実行するために Debugger>Step を選択（も
しくは Step ツールバーボタンをクリック）します。終了
後、以下のコードが表示されます。

movlwB'11000111'  ;TMR0 prescaler, 1:256

11. ウオッチウインドウのレジスタ ADCON0 とADCON1値を
確認します。ADCON0 は 40 HEX になっています。これ
はプログラムで設定されるバイナリの値に相当しますが、
正しい値でしょうか？

PIC18F452 データシート (DS39564) の A/D 変換器に関する
章によれば、A/D 変換モジュールを動作させるには最後の
ビットは１になるべきであって、０ではありません。

このバグを修正するために

movlwB'01000000';Fosc/8, A/D enabled
を

movlwB'01000001';Fosc/8, A/D enabled
に変更します。

12. File>Save を選択し変更をセーブします。
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13. Project>Build All を選択し、プロジェクトを再構築します。
プログラムが再構築されたことを示すメッセージが表示さ
れます。MPLAB ICD 2 も修正点を反映するため再プログ
ラムをしなければなりません。

14. Debugger>Program を選択し、変更されたプログラムを
MPLAB ICD 2 にプログラムします。MPLAB ICD 2 ダイア
ログに ‘...Programming succeeded’ と表示されたら、プロ
グラムは再び実行可能となります。

15. 以前にブレークポイントのあったコードライン（現在は赤
色のストップサインで表示されています。）を右クリック
します。Remove Break Point を選択します。

16. Debugger>Run を選択（もしくは Run ツールバーボタンを
クリック）し、リアルタイムモードでプログラムを実行さ
せます。ポテンシャメーター (RA0) を回し、LED に表示
される値を変更します。

このチュートリアルのソースコードでは一つのバグしかありま
せん。しかし、実際のコードではもっと多くのバグがあるかも
しれません。MPLAB ICD 2 と MPLAB IDE のデバッグ機能を用
いて、そのコードにある問題を見つけ修正することができます。

3.12 アプリケーションのプログラム

プログラムがうまくデバッグできて実行できるようになったら、
通常次のステップは、最終設計システムで単独動作させるため
に PICmicro MCU にプログラムすることです。これを行う時に
は、ICD のために確保されていたリソースは、アプリケーショ
ンプログラムで使用できるように開放されます。

アプリケーションプログラムをプログラムするには、以下のス
テップに従ってください。

1. Debugger>Select Tool>none を選択し、MPLAB ICD2 のデ
バッグツール機能を無効にします。

2. Programmer>Select ToolメニューでMPLAB ICD 2をプログ
ラマモードにします。

3. オプションとして、Configure>ID Memory で ID を設定しま
す（図 3-15 参照）。
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図 3-15： ユーザ ID ダイアログ

4. Programmer>Settings プログラムタブでプログラム用の　
パラメータを設定します。

5. Programmer>Program を選択します。

これで、MPLAB ICD 2 はリセットされターゲットシステムが実
行されます。(MPLAB ICD 2 もターゲットボードからはずし、リ
セット発行後、アプリケーションプログラムが実行されます。)

3.13 TUT452 のメインルーチンとソースコード

図 3-16 で示す TUT452.asmメインルーチンは、PORTB, A/D 
変換モジュール、Timer0 のコンフィギュレーションすることか
ら始まります。ポテンシャメーターからの値を A/D 変換開始す
るために、Timer0 がオーバーフローするまで待ちます。変換が
完了したら、変換後の値が LED に表示され、プログラムはルー
プバックし、次の A/D 変換開始するために、Timer0 がオーバー
フローするまで待ちます。  
A/D変換動作と関連するアプリケーションノートのリストについ
ての詳細は、 PICmicro 18C MCU Family Reference Manual 
(DS39500) を参照ください。
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図 3-16： TUT452 メインルーチンフロー

START
Configure PORTB

as All Outputs

Configure A/D
left justify, FOSC/8 clock

1 analog channel

Configure Timer0
Prescaler assigned to Timer0

1:256 prescale

Timer0 Overflow?
No

Yes

Start A/D Conversion

ConversionNo

Yes

Complete?

Write A/D Result to PORTB
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;****************************************
;*              TUT452.ASM              *
;****************************************

    list p=18f452

    include "p18f452.inc" 
    
Reset_Vector code 0x0   ; Put a GOTO at reset address

     goto  Start

     code  0x0002A      ; Start app beyond vector area
Start
    clrf   PORTB        ;Clear PORTB
    clrf   TRISB        ;PORTB all outputs,
                        ;display 4 MSB's of A/D result on LEDs
    movlw  B'01000000'  ;Fosc/8,A/D enabled
    movwf  ADCON0
    movlw  B'00001110'  ;Left justify,1 analog channel
    movwf  ADCON1       ;VDD and VSS ref’s    
    movlw  B'11000111'  ;TMR0 prescaler,1:256
    movwf  T0CON

Main
    btfss  INTCON,TMR0IF ;Wait for Timer0 to timeout
    goto   Main
    bcf    INTCON,TMR0IF

    bsf    ADCON0,GO     ;Start A/D
                         ;conversion
Wait
    btfss  PIR1,ADIF     ;Wait for conversion to complete
    goto   Wait

    swapf  ADRESH,W      ;Swap A/D result nibbles
    andlw  0x0f          ;Mask off lower 4 bits
    movwf  PORTB         ;Write A/D result to PORTB

    clrf   PORTB

WaitPush                 ;Pause while switch is pressed
    btfss  PORTA,4
    goto   WaitPush

    movwf  PORTB
    goto   Main        ;Do it again

    end
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NOTES:
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第 4 章 USB インストールの詳細

ユーザーズガイド
4.1 序章

この章では USB ドライバソフトを種々の Windows オペレー
ションシステムにインストールするための詳細をカバーします。
このシステムは以下のオペレーションシステム（OS）をカバー
しています。

• Windows 98/ME
• Windows 2000
• Windows XP
USB ドライバーが正しくインストールされないと問題は発生し
ます。Windows はしばしばデフォルトの USB ドライバソフト
をインストールします。このドライバソフトでは MPLAB ICD 2
が動作しません。もし問題が出たら、ハードウエアデバイスマ
ネジャを見て、Microchip USB driver が USB デバイスリストに
あるかどうかの確認を行ってください。時には、不明の USB デ
バイスが他のデバイスリストにリストされることがあります。
もしこのようなデバイスが見つかったら削除し、以下の各 OS
のインストール手順を実行してください。

図 4-1 に正しいコンフィギュレーションを示します。

図 4-1： デバイスマネジャ
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4.2 WINDOWS 98 と WINDOWS ME 
へのインストール

4.2.1 ステップ 1
新しい USB デバイスが最初に Windows 98/ME システムに接続
されル時に、ダイアログボックスが現れ、システムが新しい
ハードウエアデバイスを発見したことを表示します。さらにデ
バイスデータベースが構築され更新されることを通知するダイ
アログボックスが現れることもあります。

これらのダイアログボックスの後に、“Add New Hardware Wiz-
ard” ダイアログボックスが表示されます。Next をクリックし、
インストールを続けます。

図 4-2： WINDOWS 98/ME 新しいハードウエアウイザード - 1
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4.2.2 ステップ 2
“Search for the best driver...” が選択されたことを確認し、Next を
クリックします。

図 4-3： WINDOWS 98/ME 新しいハードウエアウイザード - 2

注： INF もしくはデバイスドライバのファイルを見つけ
たり認識したりすることができなかった場合は、ス
テップ 2 を繰り返し、“Display a list of all the 
drivers...” を選択します。次のスクリーンでデバイ

スタイプを聞いてきます。この時点で、Have Disk
ボタンをクリックします。次のダイアログボックス
で .INFファイルが見つかるはずのディレクトリパ
スが選択できます。このディレクトリが選択されれ
ば、OK をクリックし、インストールを継続しま
す。
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4.2.3 ステップ 3
次のダイアログボックスでは、新しいデバイスに必要なファイ
ルを選択できます。チェックボックスは、“Specify a location” 以
外のところはチェックしません。“Specify a location” を選択し、
ドライバーファイルのパスを入力します (もしくはパスを入力
するかブラウザーで検索します )。通常のインストールではこの
パスは以下のようになります。

C:\Program Files\MPLAB IDE\Drivers98\ICD2_USB

このパスには以下のファイルが含まれているはずです。

• ICD2W98.INF

• ICD2W98.SYS

• ICD2W98L.SYS

パスが指定されたら、Next をクリックします。

図 4-4： WINDOWS 98/ME 新しいハードウエアウイザード - 3
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4.2.4 ステップ 4
次のダイアログボックスでは “Microchip MPLAB ICD 2 Firmware 
Loader” が見つかったことが示され、前ステップで選択されたパ
スが表示されます。Next をクリックします。

図 4-5： WINDOWS 98/ME 新しいハードウエアウイザード - 4
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4.2.5 ステップ 5
次のダイアログボックスでは “Microchip MPLAB ICD 2 Firmware 
Loader” がインストールされたことが表示されます。このプロセ
スを完了させるには、Finish をクリックします。

この時点では、MPLAB ICD 2 が再認識されます。この状態を示
す別のダイアログボックスが表示されます。システムは自動的
に、デバイスと通信するために必要な MPLAB ICD 2 USB client 
driver をインストールします。

新しいダイアログボックスが別のパスを聞いてきたら、ステッ
プ 3 と同じパスを入力してください。

図 4-6： WINDOWS 98/ME 新しいハードウエアウイザード - 5
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4.3 WINDOWS 2000 へのインストール

MPLAB ICD 2がWindows 2000システム上に初めて接続される場
合、デバイスドライバソフトを正しくインストールするために
以下のステップを実行します。

4.3.1 ステップ 1 
新しい USB デバイスが最初に Windows 2000 システムに接続さ
れル時に、ダイアログボックスが現れ、システムが新しいハー
ドウエアデバイスを発見したことを表示します。さらにデバイ
スデータベースが構築され更新されることを通知するダイアロ
グボックスが現れることもあります。

これらのダイアログボックスの後に、“Found New Hardware 
Wizard” ダイアログボックスが表示されます。Next をクリック
し、インストールを続けます。

図 4-7： WINDOWS 2000 新しいハードウエアウイザード - 1 
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4.3.2 ステップ 2
“Search for a suitable driver...” が選択されたことを確認し、Next
をクリックします。

図 4-8： WINDOWS 2000 新しいハードウエアウイザード - 2

 

注： INF もしくはデバイスドライバのファイルを見つけ
たり認識したりすることができなかった場合は、ス
テップ 2 を繰り返し、“Display a list of the known 
drivers...” を選択します。次のスクリーンでデバイ

スタイプを聞いてきます。この時点で、Have Disk
ボタンをクリックします。次のダイアログボックス
で INFファイルが見つかるはずのディレクトリパ
スが選択できます。このディレクトリが選択されれ
ば、OK をクリックし、インストールを継続しま
す。
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4.3.3 ステップ 3
次のダイアログボックスでは、新しいデバイスに必要なファイ
ルを選択できます。チェックボックスは、“Specify a location” 以
外のところはチェックしません。“Specify a location” を選択し、
Next をクリックします。

図 4-9： WINDOWS 2000 新しいハードウエアウイザード - 3
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4.3.4 ステップ 4
“Copy manufacturer's files from:” と表示された編集フィールドで
デバイスドライバファイルへのパスを入力します（もしくはパ
スを入力するか “Browse” ボタンを用いて検索しパスを入力しま
す。）。通常のインストールでは、このパスは以下のようになり
ます。

C:\Program Files\MPLAB IDE\Drivers2000\ICD2_USB 
このパスは以下のファイルを含んでいます。

• ICD2W2K.INF

• ICD2W2K.SYS

• ICD2W2KL.SYS

パスが指定されたら、OK をクリックします。

図 4-10： WINDOWS 2000 新しいハードウエアウイザード - 4
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4.3.5 ステップ 5
次のダイアログボックスでは、ウイザードが、前のステップで
指定されたロケーションでデバイスドライバを見つけたことを
表示します。Next をクリックします。

図 4-11： WINDOWS 2000 新しいハードウエアウイザード - 5 
 2004 Microchip Technology Inc. DS51331A_JP-page  63



MPLAB® ICD 2 ユーザーズガイド

newICD2_UG.book  Page 64  Thursday, January 6, 2005  3:38 PM
4.3.6 ステップ 6
次のダイアログボックスでは “Microchip MPLAB ICD 2 Firmware 
Loader” が見つかったことが示され、以前に選択されたパスが表
示されます。Next をクリックします。

図 4-12： WINDOWS 2000新しいハードウエアウイザード - 6 

最後のダイアログボックスでは “Microchip MPLAB ICD 2 Firm-
ware Loader” がインストールされたことが表示されます。この
プロセスを完了させるには、Finish をクリックします。

この時点では、MPLAB ICD 2 が再認識されます。この状態を示
す別のダイアログボックスが表示されます。システムは自動的
に、デバイスと通信するために必要な MPLAB ICD 2 USB client 
driver をインストールします。
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新しいダイアログボックスが別のパスを聞いてきたら、ステッ
プ 4 と同じパスを入力してください。

図 4-13： WINDOWS 2000 新しいハードウエアウイザード - 7
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4.4 WINDOWS XP へのインストール

4.4.1 ステップ 1
新しい USB デバイスが最初に Windows XP システムに接続され
る時に、ダイアログボックスが現れ、システムが新しいハード
ウエアデバイスを発見したことを表示します。さらにデバイス
データベースが構築され更新されることを通知するダイアログ
ボックスが現れることもあります。

これらのダイアログボックスの後に、“Found New Hardware 
Wizard” ダイアログボックスが表示されます。“Install from a list 
or specific location (Advanced)” を選択し、Next をクリックし、
インストールを続けます。

図 4-14： WINDOWS XP 新しいハードウエアウイザード - 1
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4.4.2 ステップ 2
“Search for the best driver...” が選択されていることを確認しま
す。“Search removable media” は選択せず、“Include this loca-
tion in the search” をチェックします。MPLAB IDE インストール
ディレクトリを開き、DriversXP\ICD2_USB サブディレクトリ
を選択します。Next をクリックします。

インストール中は、“The software you are installing for this hard-
ware...has not passed Windows Logo testing...”と書かれるダイア
ログが表示されます。Continue Anyway をクリックします。

注： INF もしくはデバイスドライバのファイルを見つけ
たり認識したりすることができなかった場合は、ス
テップ 2 を繰り返し、“Don't search. I will choose...”
を選択し Next をクリックします。次のスクリーン
でデバイスタイプを聞いてきます。“Show All 
Devices” が選択されていることを確認し Next をク
リックします。“Select the device driver...” ウインド

ウで、Have Disk ボタンをクリックします。次のダ
イアログボックスで INFファイルが見つかるはず
のディレクトリパスが選択できます。MPLAB IDE
インストールディレクトリを開き、サブディレクト
リ DriversXP\ICD2_USB を選択します。このディ
レクトリが選択されれば、OK をクリックし、イン
ストールを継続します。
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図 4-15： WINDOWS XP 新しいハードウエアウイザード - 2
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4.4.3 ステップ 3
Microchip MPLAB ICD 2 Firmware Loader のインストールが完了
すれば “Completing the Found New Hardware Wizard” が表示さ
れます。Finish をクリックしてこのインストールを終了し、
Firmware Client のインストールを開始します。

図 4-16： WINDOWS XP 新しいハードウエアウイザード - 3
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4.4.4 ステップ 4
システムが新しいハードウエアデバイスの追加を完了すると、
次に、新しいハードウエアが見つかったことを示すダイアログ
ボックスが表示されます。

このダイアログボックスが表示された後、Found New Hardware 
Wizard ダイアログボックスが再び表示され、Microchip MPLAB 
ICD 2 Firmware Client をインストールします。“Install from a list 
or specific location (Advanced)” を選択し、Next をクリックし、
インストールを継続します。

図 4-17： WINDOWS XP 新しいハードウエアウイザード - 4
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4.4.5 ステップ 5
“Search for the best driver...” が選択されていることを確認しま
す。“Search removable media” は選択せず、“Include this loca-
tion in the search” をチェックします。MPLAB IDE インストール
ディレクトリを開き、DriversXP\ICD2_USB サブディレクトリ
を選択します。Next をクリックします。

インストール中は、“The software you are installing for this hard-
ware...has not passed Windows Logo testing...”と書かれるダイア
ログが表示されます。Continue Anyway をクリックします。

図 4-18： WINDOWS XP 新しいハードウエアウイザード - 5
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4.4.6 ステップ 6
Microchip MPLAB ICD 2 Firmware Client がインストールされる
と、“Completing the Found New Hardware Wizard” が現れます。
Finish をクリックし、USB インストールを終了します。

図 4-19： WINDOWS XP 新しいハードウエアウイザード - 6
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第 5 章トラブルシューティング

ユーザーズガイド
5.1 トラブル時発生時にすべきこと

MPLAB IDE, MPLAB ICD 2, PICmicro MCU ターゲットアプリ
ケーション回路に関する多くのことは MPLAB ICD 2 の動作に影
響を与えることがありますので、一連の ICD 2 機能に関連する
動作を理解することは重要なことです。

図 5-1 は種々の関連を示しています。プログラムやデバッグの
ためには、MPLAB ICD 2 が個々のリンクで動作せねばなりませ
ん。この章ではこれらのリンクについて議論し、もし問題が発
生した場合に、それを見つけ修正するための一助になるように
します。 

図 5-1： MPLAB ICD 2 の一連の機能
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5.1.1 リンク：PC と ICD 2 の通信

このリンクは、以下に続くリンクの基礎となります。もしこの
機能が動作しないと、MPLAB IDE で通信エラーが発生します。
MPLAB USBドライバが手順書通りにインストールされているこ
とを確認してください。MPLAB ICD 2 ドライバが正しく PC に
インストールされているかを確認するには、Windows のハード
ウエアマネジャダイアログの USB セクションをご覧ください。
RS-232 を使用する場合は、FIFO バッファがオフになっており、
COMM ドライバダイアログでフローコントロールがハードウェ
アと設定されていることを確認してください。ハードウエアマ
ネジャの USB セクションの中に MPLAB ICD 2 USB ドライバが
見つからない時は、MPLAB IDE インストールディレクトリに進
み、\DriversXXXフォルダ（XXXは 98, NT, XP 等、OS の名前
に相当します）を開いてください。ウエブブラウザで HTM ファ
イルを開き、適切な OS にドライバをインストールための詳細
を見てください。USB のインストール詳細については、第 4 章
をご覧下さい。

5.1.2 リンク： ICD 2 ファームウエア 
最新版のファームウエアが MPLAB ICD 2 にインストールされて
いることを確認してください。MPLAB IDE ソフトウエアを用い
て更新されたファームウエアのダウンロードができます。最新
版のソフトウエア製品は、常に Microchip ウエブサイトからダウ
ンロードできます。 
ファームウエアのバージョンは、どのターゲット PICmicro がサ
ポートされているかで決定されます。ファームウエアと MPLAB 
ICD 2 の最新情報については README をご覧下さい。
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5.1.3 リンク：ICD 2 とターゲット PICmicro
すべてのラインが接続され、VPP、PGC、PGD の ICD 信号ライ
ンに信号や部品が接続されていないことを確認してください。
もし MPLAB ICD 2 の VDD と VSS 信号がターゲットボードの電
源やグランドに接続されていなければ動作しません。MPLAB 
ICD 2 はターゲットボードの回路に電源を供給 (Debugger>Set-
tings ダイアログのパワータブ, “Power target circuit from MPLAB 
ICD 2” を選択することで実現 ) することで、 VDD (<200mA, 5 
voltsのみ)をターゲットボードに供給し出力バッファに供給でき
ます。そうでなければ、ターゲットボードの VDD が使用されま
す。 VDD は MPLAB ICD 2 によって感知され、電圧レベルが正し
いかどうかはチェックされます。ターゲットボードの VDD から
電源供給することで、ターゲットボードが低電圧動作のための
レベル変換ができます。MPLAB ICD 2 の内蔵バッファ回路の簡
易図を図 5-2 に示します。 

図 5-2： MPLAB ICD 2 の内蔵バッファ回路
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もし MPLAB ICD 2 の VDD ライン上（ ICD コネクタの 2 番ピン）
に電圧がかかっていなければ、MPLAB ICD 2 は動作しません。
オシロスコープで観測すれば、PGC と PGD の通信ラインに、
ターゲット VDD-VSS 電圧のピーク to ピーク振幅値を持つ波形
が観測されねばなりません。VPP には、動作状態によって、
+12, +5, 0V のレベルが観測されるはずです。これらの信号は、 
MPLAB から ICD 2 動作コマンドが発行される後観測できます。
それ以外は、すべての信号ラインはノイズフリーのアイドル状
態となります。 

5.1.4 リンク：ターゲットボード上の電源

MPLAB ICD 2はターゲットのPICmicro MCUのVDD電圧が2Vから
5.5V 以内の範囲で動作します。アプリケーションボードには専
用の電源供給が必要です。MPLAB ICD 2 内の PGC、PGD I/O ド
ライバはターゲットボードの VDD から電源供給されます 

（図 5-2 参照）。

5.1.5 リンク：ターゲットボード上の発振器

デバイスをプログラミングする際には、発振器を動作させるこ
となくプログラムできますが、ターゲットボードの発振器が機
能していなければ、デバッグ機能は動作しません。インサー
キットエミュレータと異なり、デバッグ中は、MPLAB ICD 2 に
とってはターゲットボードの PICmicro MCU が動作しているこ
とが必要です。

ターゲットシステムが命令を正しく実行していることを確認す
るために、なんらかのテストが必要になります。例えば、LED
を点滅させる小さなプログラムを作成し、MPLAB ICD 2 デバッ
グ機能を無効にしたまま、ターゲットの PICmicro MCU にプロ
グラムします。ICD をはずしターゲットボードをリセットしま
す。もし LED が点滅しなければ、回路をチェックしなぜ動作し
ないかを見つける必要があります。もし MPLAB ICD 2 が、ター
ゲットボードのプログラミング後、デバッグ無効の状態で接続
されていても、MPLAB はリセットを発行できます。もし
(MPLAB IDE の Debugger>Run を選択後 )ICD が接続されてい
ない状態でスタンドアローンで動作したとすると、ICD 2 は誤動
作する場合があります。オシロスコープを用い、PGC、PGD、
VPP を確認してください。発振器がすばやく立ち上がっているこ
とを確認してください。もし立上がりに時間がかかっているよ
うであれば、MPLAB ICD 2 はタイムアウトによりエラーを発行
します。
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正しい発振モードが選択されていることを確認(Configure>Con-
figurations Bits を確認 )してください。発振モードは選択された
発振器に依存します。水晶発振子の場合は HS モードを、外付
け抵抗 /キャパシター発振子の場合は RC モードを試してみて
ください。これらの設定は最終デザインに向けて修正される必
要があるかもしれませんが、デバッグ開始にあたっては一番判
り易いモードです。コンフィギュレーションビットがプログラ
ミング時に設定され、デバッグもしくは通常動作モードで電源
が供給された後に、発振動作は OSC2 端子で確認できます。

5.1.6 リンク：アプリケーションコード

リンク：ターゲットボード上の発振器の章で述べられた方法と
似たような LED 点滅テストプログラムを実行させるか、もしく
はターゲットデバイスにコードをプログラミングすることで、
MPLAB ICD 2 が正しくプログラミングされたことを検証します。
MPLAB ICD 2 はプログラミング後、タ―ゲット PICmicro MCU 内
のデータが MPLAB プログラムメモリ内のデータと一致するか
を確認するためにベリファイを実行します。Programmer>Verify
を手動で選択することで、ターゲット PICmicro のメモリと
MPLAB IDE イメージを比較することができます。もしターゲッ
ト PICmicro MCU が AVDD と AVSS を持っていたら、これらが
正確に接続されているかどうかを確認してください。これらの
ラインはそれぞれ電源 (VDD) と グランド (VSS) に接続しま
す。詳細についてはデバイスのデータシートを参照ください。
もしこれら電源がありかつ接続されていなければ MPLAB ICD 2
は動作しません。低電圧プログラミングが無効であることを
(Config>Configuration Bits...) 確認して下さい。 

5.1.7 リンク：デバッグエグゼクティブ

MPLAB IDE から Debugger>Program を使用する際には、デバッ
グエグゼクティブをダウンロードし、ターゲット PICmicro 
MCU 内のインサーキットデバッグレジスタを有効にします。プ
ログラミングは、プログラマメニューではなく、常にデバッグ
メニューから実行されねばなりません。 ( デバッガとして
MPLAB ICD 2 をオフした後 ) プログラマメニューからプログラ
ミングする場合 ,デバッグエグゼクティブはダウンロードされ
ず、インサーキットデバッグレジスタは無効になります。 
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Config>Configuration Bits... メニュー選択を見れば、MPLAB がデ
バッグエグゼクティブをダウンロードしようとしているかどう
かが判断できます。もし “Background Debug” ビットが有効であ
れば、デバッグイグゼクティブは、デバイスがプログラムされ
る時にダウンロードされます。

5.1.8 リンク：インサーキットデバッグレジスタ

デバイスをプログラミングする前に、MPLAB 中の MPLAB 
ICD 2 ダイアログで、デバッグが有効になっていることを確認し
てください。Config> Configuration Bits... ダイアログを見れば、
インサーキットデバッグレジスタが有効になっていることを検
証できます。“Background Debug” ラインが “Enabled.” になって
いなければなりません。プログラミングは、Debug メニューか
ら実行されるべきであり、Programmer メニューからではあり
ません。

5.1.9 リンク：インサーキットデバッグリソース

オンラインヘルプにある、デバイスに使われる特別なレジスタ
を見てください。MPLAB ICD 2 で確保されるファイルレジスタ
もしくはプログラムメモリは使用できません。xxxxxi.lkr（i
で終わる名前）のリンカスクリプトを使用する場合、スクリプ
トに変更を加わっていない限り、このリソースはリザーブされ、
アプリケーションソフトでは使用できません。もしリンカが使
用されないのであれば、CBLOCKもしくは EQUを用い変数を宣
言し、MPLAB ICD 2 で必要とされるレジスタは使用されていな
いことを確認して下さい。“code protect” もしくは “table read 
protect” が有効であるか、ウオッチドッグタイマが実行されてい
るか、発振器がコンフィギュレーションビットで設定される正
しいモードに設定されていない場合は、インサーキットデバッ
ガは動作しません。ファースト割り込みもしくは CALL FAST命
令を使用している場合は、MPLAB ICD 2 は シャドウスタックを
使用し、ユーザはファースト割り込みルーチンもしくは CALL 
FASTファンクションから正しく抜け出すことはできません。 
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第 6 章 よくある質問

ユーザーズガイド
6.1 よくある質問

以下の問題が、この章でよくある質問としてカバーされていま
す。

6.1.1 なぜ自分のシステムでプログラムやベリファイがうまくい
かないのでしょうか？

6.1.2 なぜ ICD ヘッダアダプタが必要なのでしょうか？

6.1.3 MPLAB ICD 2 に接続できません。何をしなければならない
ので しょうか？

6.1.4 ICD 2 が “Target not in debug mode error.” を返してきまし
た。これはどういう意味でしょうか？

6.1.5 MPLAB ICD 2 は、低電圧で動作しているターゲットデバイ
スと一緒に動作できますか？

6.1.6 MPLAB ICD 2 は低電圧プログラミング (LVP) をサポートし
ていますか？

6.1.7 PLL Oscillatorを設定する時になぜ問題が発生するのでしょ
うか？ MPLAB ICD 2 がハングアップしてしまいます。

6.1.8 インストールする時に、ドライバフォルダは見え、ドライ
バウイザードで正しいフォルダを指定しているのに、なぜ
ドライバソフトがみつからないのでしょうか？

6.1.9 MPLAB ICD 2 でコードプロテクトを使用できますか？

6.1.10 MPLAB ICD 2 はどのようにキャリブレーションデータを
あつかうのでしょうか？

6.1.11 なぜ自分のEEDATA領域から誤った値が出てくるのでしょ
うか？

6.1.12 なぜ “Erase All Before Programming” はグレーアウトされ
ているのでしょうか？

6.1.13 MPLAB ICD 2 を中断すること無しに、Port B もしくは 
GPIO の読み書きはできませんか？
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6.1.14 なぜ、シングルステップ動作時に、タイマの動作が間
違っているように見えるのでしょうか？

6.1.15 PIC12F629/675 もしくは PIC16F630/676 を使用するとき
に、警告やエラーが発生するのはなぜでしょうか？

6.1.16 電源やビジー LED が点滅するのはなぜでしょうか？

6.1.17 MPLAB ICD 2 の “Self Test” とは何をするのでしょうか？

6.1.18 RETFIE命令と一緒に高優先度割り込みを使用すると W、
STATUS、BSR のレジスタの値が変化するのはなぜで
しょうか？

6.1.19 自分のプログラムで最初の位置にブレークポイントを設
定すると、アドレス 0000 ではなく、0001 で停止するの
はなぜでしょうか？

6.1.20 キャリブレーションメモリがブランクの値として表示さ
れるのはなぜでしょうか？

6.1.21 コードをシングルステップ動作させると、タイマがタイム
アウトを発生しますが、なぜタイマ割り込みルーチンが
起動しないのでしょうか？

6.1.1 質問：なぜ自分のシステムでプログラムやベリ
ファイがうまくいかないのでしょうか？

回答：第 5 章のトラブルシューティングで述べられているよう
に、PGC、PGD、VPP の接続や電圧を確認してください。ター
ゲット PICmicro MCU に電源が供給されていることを確認して
ください。もしターゲット PICmicro MCU が AVSS や AVPP 持っ
ているなら、これらのピンも正しく接続されていることを確認
してください。

6.1.2 質問：なぜ ICD ヘッダアダプタが必要なので
しょうか？

回答：もしインサーキットデバッグピンがデバッグ用に確保さ
れると、MPLAB ICD 2 でサポートされている少ピン数のデバイ
スは有効的に使用できません。--8 ピンデバイスで、6 本の I/O
のうち 3 本がない場合を想像してください。この理由のため、
特別なボンディングをされた PICmicro が作られ、これがアダプ
タを使用して少ピン数デバイスをエミュレーションし、これに
よりターゲットアプリケーションにおいてすべてのピンが使用
できるようになります。この特別ボンディングされた PICmicro 
MCU は MPLAB ICD 2 とのインターフェースをとるために、イン
サーキット通信ピンを持っています。 
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これの利点は、MPLAB ICD 2 で開発する際に、少ピン数のデバ
イスを使用できることです。欠点は、これらの部品は、イン
サーキットデバッギングのために、ターゲットアプリケーショ
ン上での ICD 2 コネクタが簡単にはできないことです。この特
別ボンディングされた PICmicro はエミュレータチップに似てい
ます。それらは、1 個以上のデバイスをサポートできます。開
発中のデバイスに適合するようにこのチップのコンフィギュ
レーションするために、ヘッダボード上にはジャンパが用意さ
れています。この少ピン数デバイスは、ユニバーサルプログラ
ムアダプタを用いるか、ターゲットアプリケーション上に ICD 2
コネクタをセットし、これらのデバイスの VPP、PGC、PGD と
接続させることにより、MPLAB ICD 2 でプログラムできます。

6.1.3 質問：MPLAB ICD 2 に接続できません。何をし
なければならないのでしょうか？

回答：MPLAB ICD 2 の電源ライトは点灯していますか？ LED が
明るく光っていなければなりません。もし暗いようでしたら、
USB のみが接続され、ユーザボードが電源に接続されていない
かもしれません。PC からの RS-232 接続では、MPLAB ICD 2
に電源供給ができませんが、USB 接続では供給可能です。USB
ハブには電源供給ができないものもある点に注意してください。
このトラブルシューティングのヒントを得るために、オンライ
ンヘルプをチェックしてください。USB ドライバは適切にイン
ストールされていますか？ MPLAB ICD 2 USB ドライバは Win-
dows Device Manager ダイアログ（図 6-1 参照）で見えなければ
なりません。USB ハブの中には接続された USB デバイスに電
源供給できないものがあります。そのような HUB を使う場合
は、電源を MPLAB ICD 2 に接続する必要があります。

図 6-1： システムプロパティダイアログ
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6.1.4 質問：ICD 2 が “Target not in debug mode 
error.” を返してきました。これはどういう
意味でしょうか？

回答：通常これは、MPLAB ICD 2 がデバッグエグゼクティブと
通信できないことを意味します。デバッグエグゼクティブは、
Debugger>Program メニューから、ユーザアプリケーションを
ターゲット PICmicro MCU にプログラムすることでのみダウン
ロードされます。ターゲットボードのクロックもしくは電源供
給の問題等、デバッグエグゼクティブが通信できなくなる他の
理由もあります。コンフィギュレーションビットを確認し、
“Background Debug” が有効になっていることを確認してくださ
い。ウオッチドックタイマが無効、コードプロテクションがオ
フ、発振器の設定が正しい、ことを確認するために、 
Config>Configuration Bits... を見てください。  

6.1.5 質問：MPLAB ICD 2 は、低電圧で動作している

ターゲットデバイスと一緒に動作できます
か？

回答：はい、できます。ターゲット PICmicro MCU が低電圧動
作をサポートしていれば、VDD 2.0 ボルトまでの低い電圧で動
作できます。MPLAB ICD 2 の入出力バッファにレベル変換器が
あります。これらは、ターゲットデバイスの VDD から電源供給
されます。また、MPLAB ICD 2 はターゲットの動作電圧を検知
し、この動作に対応するために正しく機能調整します、すなは
ち、正しい FLASH 消去アルゴリズムを使用します。VDD につい
ては、MPLAB ICD 2 “Settings” ダイアログの中の “From Target”
を選択する必要があり、これにより、低電圧動作のために、
ターゲット上の電源を持つことになります。

6.1.6 質問：MPLAB ICD 2 は低電圧プログラミング

(LVP) をサポートしていますか？ 
回答：いいえ、サポートしていません。しかしこれはターゲッ
ト上に低電圧 VDD で動作できないことを意味するものではあり
ません、VPP に供給するプログラミング電圧は常に +12V であ
ることを意味するだけです。 
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6.1.7 質問：PLL Oscillator を設定する時になぜ問題

が発生するのでしょうか？ MPLAB ICD 2
がハングアップしてしまいます

回答：これは実際の PICmicro の仕様です。PLL 発振器のコン
フィギュレーションビットをプログラムした後、ターゲット
ボードの電源をいったん落とし、再度電源を入れる必要があり
ます。これが行われないと、ターゲット PICmicro MCU がク
ロックを得ることができません。クロックが無いと、デバッグ
モードが動作しません。また、PLL モードを切替えるときに、
もし電源を落とさないまま再接続を行うと、デバイスは動作す
るかもしれませんが、しかし PLL 逓倍器は動作しません。 

6.1.8 質問：インストールする時に、ドライバフォル

ダは見え、ドライバウイザードで正しい
フォルダを指定しているのに、なぜドライ
バソフトがみつからないのでしょうか？

回答：この問題は、ドライバインストールウイザードから一旦
抜け出して、コントロールパネルの “Add New Hardware” を選択
することで解決できます。システムが新しいハードウエアを検
索した後、“No, the device isn’t in the list.” を選択します。それか
ら、“No, I want to select the hardware from a list.” を選び、さら
に “Universal Serial Bus Controller,” を選びます。“Have Disk...”
ボタンが現れたら、ドライバフォルダに入り、適切なドライバ
ソフトを選択します。

6.1.9 質問：MPLAB ICD 2 でコードプロテクトを使用

できますか？

回答：いいえできません。コードプロテクション、特に、プロ
グラムメモリの領域に関してのテーブルリードプロテクション
を行うと、MPLAB ICD 2 は動作しません。MPLAB ICD 2 でデ
バッグする際には、コードプロテクションもしくはテーブル
リードプロテクションの設定はしないで下さい。コードプロテ
クションは、MPLAB ICD 2 を使わずに、テスト用プログラムを
書き込む際に有効にすることはできます。
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6.1.10 質問：MPLAB ICD 2 はどのようにキャリブレー

ションデータをあつかうのでしょうか？

回答：自動的に取り扱われます。PICmicro MCU のプログラム
メモリに格納されるキャリブレーションデータは、消去、プロ
グラム、デバッグ時に MPLAB ICD 2 で読み出され保持されま
す。このデータをプロテクトする必要はありません。

6.1.11 質問：なぜ自分の EEDATA 領域から誤った値が

出てくるのでしょうか？

回答：MPLAB ICD 2 は EEDATA 領域を直接読み出し出来、命令
の TABLRD シーケンスに必要な、EECON レジスタのアクセス
は不要です。MPLAB が使用するバッファはユーザのコードの邪
魔をする場合があります。コードをシングルステップする場合
は、データをプログラムで読み出して、EEDATA 領域の読出し
を MPLAB ICD 2 で行うような行ったり来たりは避けるようにし
てください。

6.1.12 質問：なぜ “Erase All Before Programming” は

グレーアウトされているのでしょうか？

回答：新しい FLASH デバイスの中には、プログラムメモリの不
連続領域にはバンクという形でプログラムするアルゴリズムが
必要です。このような部品の場合は、プログラム前にすべての
メモリ領域は消去されねばなりません。

6.1.13 質問：MPLAB ICD 2 を中断すること無しに、

Port B もしくは GPIO の読み書きはできま
せんか？

回答：はいできます。インサーキットデバッグが有効の場合、
PGC と PGD は常に MPLAB ICD 2 で使用され、PORT B からの
ユーザコードの読み書きは影響を受けません。PGC と PGD か
ら値を読み出すことは必ずしもできるわけではありません。ま
た、この 2 ピンへの書き込みは無視されます。さらに、もし
Port B の変化割り込みが有効であれば、PGC と PGD の信号は割
り込みを発生させることはできません。 
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6.1.14 質問：なぜ、シングルステップ動作時に、タイ
マの動作が間違っているように見えるので
しょうか？

回答：これは、インサーキットデッバガを使用する際の欠点の
一つです。コードは実際にデバッグエグゼクティブの中で動作
するので、ユーザアプリケーションプログラムが中断しても、
タイマは、デバッグエグゼクティブの動作中は引続き動作しま
す。

6.1.15 質問：PIC12F629/675 もしくは PIC16F630/676
を使用するときに、警告やエラーが発生す
るのはなぜでしょうか？ 

回答：これらのデバイスの GP1/RA1 ピンは、MPLAB ICD 2 使
用中はハイ側にはプルアップできません。ICD 2 でこれらのデバ
イスを使用するあたっての詳細は、MPLAB ICD 2 ヘッダドキュ
メント (DS51292) を参照ください。

6.1.16 質問：電源やビジー LED が点滅するのはなぜで
しょうか？

回答：これは、ターゲットの MPLAB ICD 2 コネクタが逆に接続
されていること（配線図とは逆向き）を示します。点滅は
MPLAB ICD 2 が高電流のためシャットダウンしていることを示
します。ターゲットが逆接続されていることを確認するには、
以下のテストを行ってください。

•  点滅している電源 / ビジー LED を探します。（電源は一緒に
ダウンするはずです。

• ‘Self Test’ を実行し、“MCLR=VPP” の min. error を探します。
（その他のテストはおそらくパスするはずです。） 

•  ターゲットコントローラのデフォルトアドレス領域を使い、
'Program' サイクルを実行します。pin 1 (VPP) の電圧レベル
が 7-8 ボルトだとしたら、それは低すぎます。  

もしターゲットが逆向き接続されていたら、MPLAB ICD 2 の保
護回路によりモジュールがダメージを受けることを防いでくれ
ます。ターゲットが正しく接続されていれば、正常な動作にな
るはずです。
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6.1.17 質問：MPLAB ICD 2 の “Self Test” とは何をす
るのでしょうか？

回答：‘Self Test’ ボタンは、MPLAB ICD 2 モジュールもしくは
ターゲット接続の問題を特定するのに役立ちます。

Target VDD

‘Power from ICD2’ が選択される場合、MPLAB ICD 2 からの VDD(5V
のみ )をテストします。‘Power from target’ が選択される場合、
ターゲットからの VDD(2-6V) をテストします。  
Pass/Fail コード：

エラーは、Advanced Dialog Box の ‘Power’ 設定が適切でない、も
しくはターゲットからの VDD が規格以上 /以下であることを示し
ます。 

Module VPP

MPLAB ICD 2から、プログラムサイクル中にターゲットVPP/MCLR 
pin へ供給されるプログラミング 電圧 (VPP) をテストします。

Pass/Fail コード：

エラーは、ターゲット VPP/MCLR pin が正しく接続されていない
ことを示します。 

MCLR=Gnd
ターゲットリセットのために、MPLAB ICD 2 がターゲット VPP/
MCLR pin へのグランドレベルを供給する能力をテストします。

Pass/Fail コード：

エラーは、ターゲット VPP/MCLR pin が正しく接続されていないこ
とを示します。 

00 = Pass VDD は規格制限内です。

01 = Min error VDD は規格制限以下です。

80 = Max error VDD は規格制限以上です。

00 = Pass VPP は規格制限内です。

01 = Min error VPP は規格制限以下です。

80 = Max error VPP は規格制限以上です。

00 = Pass グランドがターゲット VPP/MCLR pin に供給さ

れています。

80 = Max error グランドレベルがターゲット VPP/MCLR pin に

とっては高すぎます。
DS51331A_JP-page  86  2004 Microchip Technology Inc.



よくある質問

newICD2_UG.book  Page 87  Thursday, January 6, 2005  3:38 PM
MCLR=VDD

通常動作時（実行時等）に、MPLAB ICD 2 がターゲット 
VPP/MCLR pin への VDD を供給する能力をテストします。

Pass/Fail コード：

エラーは、Advanced Dialog Box の ‘Power’ 設定が適切でない、も
しくはターゲットからの VDD が規格以上 /以下であることを示し
ます。

MCLR=VPP

書き込み動作時に、MPLAB ICD 2 がターゲット VPP/MCLR pin へ
の VPP を供給する能力をテストします。

Pass/Fail コード：

エラーは、ターゲット VPP/MCLR pin が正しく接続されていないこ
とを示します。

6.1.18 質問：RETFIE 命令と一緒に高優先度割り込みを
使用すると W、STATUS、BSR のレジス
タの値が変化するのはなぜでしょうか？

回答：高い優先度を持つ割り込みもしくは CALL FAST 用に用い
られるシャドウレジスタは MPLAB ICD 2 で使用されます。これ
らは MPLAB ICD 2 用に確保されたリソースです。もしブレーク
ポイントが CALL FASTサブルーチン内もしくは高優先度割り込
みのサービスルーチン内にセットされ、 RETURN FASTまたは
RETFIE命令を使用する場合に問題が発生します。

00 = Pass VDDがターゲットVPP/MCLR pinに供給されてい

ます。

01 = Min error VDD がターゲット VPP/MCLR pin にとっては低

くすぎます。

80 = Max error VDDがターゲットVPP/MCLR pinにとって高すぎ

ます。

00 = Pass VPPがターゲットVPP/MCLR pinに供給されてい

ます。

01 = Min error VPP がターゲットVPP/MCLR pinにとっては低く

すぎます。

80 = Max error VPP がターゲットVPP/MCLR pinにとっては高す

ぎます。
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6.1.19 質問：自分のプログラムで最初の位置にブレー

クポイントを設定すると、アドレス 0000
ではなく、0001 で停止するのはなぜで
しょうか？

回答：MPLAB ICD 2 はブレークポイント後の命令で停止しま
す。これはアドレス 0000 でブレークポイントが実行された場
合、プログラムカウンタは、ブレークポイントを認識した時に
は 0001 を指していることになります。もしユーザがそのコード
の最初の命令で停止させたいとしたら、アドレス 0000 には
NOP を設定しなければなりません。

6.1.20 質問：キャリブレーションメモリがブランクの

値として表示されるのはなぜでしょうか？

回答：MPLAB IDE はデフォルトのメモリ値を表示します。デバ
イス上の実値を表示するため、デバイスリードを実行しなけれ
ばいけません。

6.1.21 質問：コードをシングルステップ動作させると、
タイマがタイムアウトを発生しますが、な
ぜタイマ割り込みルーチンが起動しないの
でしょうか？

回答：シングルステップ動作時は、インサーキットデバッガは
PICmicro MCU が割り込みに応答できないようになっています。
もし応答できるとしたら、ユーザが外部割り込みを使用してい
る場合、シングルステップ動作はほとんど常に割り込みルーチ
ンに入ってしまいます。割り込みをデバッグするためには、ブ
レークポイントを割り込みサービスルーチン内で設定し、割り
込み発生後にブレークポイントで停止するようコードをに実行
してください。 
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A
AVDD .................................................................................... 9, 77
AVSS ..................................................................................... 9, 77

B
Blinking LED( 点滅する LED ) .................................................. 85
Breakpoint( ブレークポイント )の設定 ................................... 44

C
Calibration Data( キャリブレーションデータ ) .................. 84, 88
CALL FAST .............................................................................. 87
Capacitors( キャパシター ) ...................................................... 10
Circuits That Interfere with MPLAB ICD 2 
(MPLAB ICD 2 とのインターフェース回路 ) ........................... 10
Code Protect( コードプロテクト ) ..................................... 78, 83
Configuration Bits( コンフィギュレーションビット ) ........ 12, 39
Connections( 接続 )

ICD 2 .................................................................................... 7
Creating A HEX File (HEX ファイルの生成 ) ........................... 39
Customer Change Notification Service 
( 顧客への通知サービス ) ........................................................... 2

D
Debug Executive( デバッグエグゼクティブ ) .............. 15, 77, 82
Debug Mode( デバッグモード )

Requirements( 必要事項 ) .................................................. 12
Sequence Of Operations( 動作シーケンス ) ...................... 13

Debug Registers( デバッグレジスタ ) ...................................... 78
Debug Resources( デバッグリソース ) .................................... 78
Debug Tool( デバッグツール ) ................................................. 22
Debugging( デバッギング ) ................................................ 27, 44
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Demo Board( デモボード ) .......................................................41
Drivers Are Not Found( ドライバが見つからない ) ..................83

E
Enable Debug( デバッグを有効にする ) ...................................40
Erase All Before Program( プログラム前に全消去 ) .................41
Erase All Before Programming( プログラミング前に全消去 ) ..84

F
Fast Interrupts( ファースト割り込み ) ......................................78
Firmware( ファームウエア ) .....................................................74

G
Getting Started( 開始にあたり ) ....................5, 19, 31, 53, 73, 79
GP1/RA1 ...................................................................................85
GPIO ...................................................................................79, 84
Green Light( 緑色のライト ) ...............................................22, 33

H
Header Board( ヘッダボード ) ..................................................17
High Priority( 高い優先度 ) ........................................................87

I
ICD

Cable( ケーブル ) .................................................................7
Header Adapters( ヘッダアダプタ ) ...................................80

ICD 2 .........................................................................................74
ICE と ICD ..................................................................................6
ICSP ...................................................................................12, 17
In-circuit Debug Registers 
( インサーキットデバッグレジスタ ) .......................................  17
Installation( インストール ) .......................................................20
Interconnections( 相互接続 ) .......................................................8
Internal Buffer Circuits( 内部バッファ回路 ), MPLAB ICD 2 .....75
Internet Address( インターネットアドレス ) ..............................1
Interrupts( 割り込み ) ..........................................................84, 87
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L
Loading Program And Debug Code 
( プログラムとデバッグコードのロード ) ................................ 42
Locate Tools Dialog( ツールダイアログの設定 ) ...................... 37
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